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This document outlines the process for deploying Savant Pro Lamp Control products including physical installation, RacePoint Blueprint™ configuration, and 
web-based user interface setup.
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 – Savant Pro Lamp Control [SAV-LMP-0300]
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Important Safety Information - Read First
Before installing, configuring, or operating any equipment, Savant recommends 
that each dealer, integrator, installer, etc. access and read all relevant technical 
documentation. Savant technical documentation can be located by visiting 
Savant.com. Vendor documentation is supplied with the equipment.
Read and understand all safety instructions, cautions, and warnings in this 
document and the labels on the equipment.

Safety Statements
All safety instructions below should be read, understood, and applied under all 
relevant circumstances when working with this equipment. 

1. Follow all input power ratings marked on product near power input!

2. If fuse replacement is required, replacement fuse should match fuse 
rating marked on the product.

3. Do not use equipment near water.

4. Clean only with dry cloth.

5. Do not block any ventilation openings or install near any heat sources 
such as heat registers, stoves, radiators, amplifiers, etc.

6. Refer all servicing to qualified service personnel. Servicing is required 
when any part of the apparatus has been damaged in any way, or fails to 
operate normally for any reason.

7. Use only attachments/accessories specified by the manufacturer, 
following all relevant safety precautions for any such attachments/
accessories.

8. For applicable equipment, use the included power cord with the 
grounding prong intact to insure proper grounding of the device.

9. If the provided plug does not fit the desired outlet, contact a licensed 
electrician to replace the obsolete outlet.

10. Protect any power cord from being walked on, pinched, strained, or 
otherwise potentially damaged, especially at the outlet or device 
connections.

11. Disconnect any outlet powered apparatus from its power source during 
lightning storms or when unused for long periods of time.

12. To completely disconnect equipment from AC mains power, disconnect 
the power supply cord plug from the AC receptacle on the device.

13. For any hardwired or fixed in-wall apparatus, carefully follow all wiring 
diagrams and instructions. All electrical wiring and servicing should be 
performed by a properly licensed electrician.

Safety Classifications In this Document

NOTE: Provides special information for installing, 
configuring, and operating the equipment.

 IMPORTANT!
Provides special information that is critical to 
installing, configuring, and operating the equipment.

 CAUTION!
Provides special information for avoiding situations 
that may cause damage to equipment.

 WARNING!

Provides special information for avoiding situations 
that may cause physical danger to the installer, end 
user, etc.

Electric Shock Prevention

 ELECTRIC 
SHOCK!

The source power poses an electric shock hazard 
that has the potential to cause serious injury to 
installers and end users.

 ELECTRICAL 
DISCONNECT:

The source power outlet and power supply input 
power sockets should be easily accessible to 
disconnect power in the event of an electrical hazard 
or malfunction.

Weight Injury Prevention

 WEIGHT INJURY!

Installing some Savant equipment requires two 
installers to ensure safe handling during installation. 
Failure to use two installers may result in injury.

http://savant.com
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1. Before You Begin
Read this document in its entirety before starting deployment of the product, and ensure that the following required items are available:

Savant Lamp Control (SAV-LMP-0300) .....................................................................................................................................................................................

Unique ID (UID) of the Lamp Controller.. ...................................................................................................................................................................................  
Located on the back of the device.

Savant Host; licensed and running da Vinci software ...........................................................................................................................................................

Smart Connect Application installed on an iOS device ........................................................................................................................................................

SSID and Passphrase for the Wi-Fi router or switch .............................................................................................................................................................

Savant Development Environment (SDE/MacBook) .............................................................................................................................................................  
Document supports da Vinci 8.10.1 or higher.

Network meeting Savant requirements ......................................................................................................................................................................................  
See Appendix A: Network Requirements

 IMPORTANT! Device firmware updates are retrieved from the Host. Therefore, ensure the Host has a valid internet connection.

2. Deployment Steps
Follow these steps to successfully deploy the Savant Lamp Control. This page can be used as a checklist to record which steps have been completed.

Review product specifications and connection details ........................................................................................................................................................  
See the device’s Quick Reference Guide on the Savant Customer Community.

Connect hardware ...............................................................................................................................................................................................................................  
See the device’s Quick Reference Guide on the Savant Customer Community.

Provision Lamp Control onto network using SmartConnect ..............................................................................................................................................  
See Provision to the Network - SmartConnect

Add Lamp Control to a RacePoint Blueprint configuration ................................................................................................................................................  
See Blueprint Configuration - Lighting and Shade Device Manager.

http://savant.com
https://community.savant.com/Customers/Comm_Login
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3. Provisioning to the Network Using SmartConnect
Prior to adding the Lamp Control into a configuration in RacePoint Blueprint, the Lamp Control must first be provisioned to the local network. To do this, 
Savant offers the SmartConnect Application, which is available for download from the Apple App store. The SmartConnect application makes it simple to 
provision the Lamp Control to the network as well as a host of other tasks. Using SmartConnect is described in this section.
If however, the SmartConnect Application is not available, the Lamp Control can also be provisioned using the embedded Web UI. To provision using the 
embedded Web UI, refer to Appendix B: Provision to the Network – Web UI. 
The next few steps describe how to provision using the Smart Connect application.

 IMPORTANT! Verify you are using the following versions of applications.
 – SmartConnect version 1.5 or higher.
 – Bluetooth version 4.0 or higher

3.1. Required Items for Network Configuration
The following items are required to provision the Lamp Control to the network using the Smart Connect application.

iOS Device with SmartConnect (v1.5 or higher) App installed...............................................................................................................................  

Lamp Control..............................................................................................................................................................................................................................  

SSID and Passphrase for the Wireless router or switch.............................................................................................................................................  

Network meeting the Savant Network Requirements................................................................................................................................................  
(See Appendix A: Network Requirements)

3.2. SSID Guidelines
Savant Wi-Fi products can connect to a wireless network that meets the following SSID guidelines.

Maximum SSID Length: 32 characters

Maximum Passphrase Length:
WPA/WPA2: 8-50 characters

WEP: 10-26 characters
Wireless Standard: 802.11 b/g/n 2.4 GHz

Supported SSID and Passphrase Special Characters

http://savant.com
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3.3. Provisioning Using SmartConnect
Provisioning the Lamp Control using the SmartConnect application (v1.5 or higher) is described below.
1. Refer to the connections section described in the Quick Reference Guide on the Savant Customer Community for initial setup and testing   
 information. If the Lamp Control is already set up, skip that section and proceed to step 2 below.
2. By default, a new Lamp Control is set at the factory to be in Access Point Provisioning Mode. The LED will blink yellow once per second. If it is,   
 skip this step and proceed to step 3 below. If the Lamp Control is in some other state than Access Point Provisioning Mode follow the bulleted   
 steps below to set it to this mode.

 
NOTES:
 – Insert a pointed object such as a paper clip into the reset button pinhole. Press and hold 

the reset button for five seconds until LED blinks red, then release.
 – After the reset, the LED will switch to solid yellow while the Lamp Controller boots.
 – After approximately 5-10 seconds, the LED on the side of the Lamp Control starts 

blinking yellow once per second indicating it is in Access Point Provisioning Mode and 
ready to be provisioned to the local network.

 – Refer to Appendix H: LED States.

3. On the iOS device (iPad®, iPhone® etc.), open the SmartConnect Application. 
4. Locate the Lamp Control in the Devices on Bluetooth section of SmartConnect.
5. Tap the Lamp Control from the Devices on Bluetooth dialog window.

TIP! If there are multiple Lamp Controls offered in SmartConnect and the UID of the 
Lamp Control is unknown, SmartConnect can be used to locate the Lamp Control. To do 
this, tap one of the Lamp Control devices offered under the Devices on Bluetooth heading. 
The Status LED on the side of the Lamp Control device will begin to blink rapidly (yellow) 
for 5-7 seconds and if there is a lamp connected, the lamp will flash 5-7 times with the LED. 
If this is not the intended Lamp Control, tap Cancel in the Pick a Network window that 
opens. Continue till the Lamp Control you would like to provision is located.

6. In the Pick a Network dialog window that opens, tap the Join Other Network… selection (image not shown).

http://savant.com
https://community.savant.com/Customers/Comm_Login
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7. In the Other Network dialog window that opens (shown below), enter the following:

Name – Enter SSID of the network.
Security - Tap Choose in the Security field and select the security configured in the local 
network.
Password - Enter Password to the local network

TIP! Tap the Use Current Network SSID field to auto populate the Name field with the SSID 
of the local network that the iOS device is currently communicating on.

8. Tap Join when complete.

 A Provisioning Success dialog window will open informing the user that the device successfully provisioned to the network. Tap OK.

 

 The Lamp Control is now provisioned to the local network. The LED on the side of the Lamp Control will now blink green indicating it is    
 connected to the network but has not established a binding to the Savant Pro System. Refer to Appendix H: LED States for more information.
 Additional Information
 The provisioned Lamp Control will now be displayed in the Devices on Wi-Fi section of SmartConnect. The next step is to configure the Lamp   
 Control into RacePoint Blueprint and bind to the Savant Pro System.

http://savant.com
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4. Blueprint Configuration - Lighting and Shade Device Manager
These instructions describe how to add a Savant lamp controller to a Blueprint configuration when both the configuration and binding processes are 
completed on-site. During this process, an integrator walks around the job site with a Blueprint configuration loaded on an SDE/MacBook. Using the 
Lighting and Shades Device Manager from Blueprint, each lamp controller is discovered, added to an existing configuration, and then bound. In this 
process, no lighting configuration is required prior to getting to the job-site.

 HELPFUL (READ BEFORE PROCEEDING)

 – Ensure the lamp controller is plugged into an AC outlet and a lamp is plugged into the lamp controller’s output.
 – Close the rpmEmbeddedScanner application. The Lighting and Shades Device Manager will not function while this application is open.

4.1. Configure Blueprint to Group by Device Type
The lamp controllers in the Lighting and Shades Device Manager can be listed By Device Type, By Location, or By Zone Group. Grouping By Device 
Type is the easiest to view and understand.

1. From the Blueprint menu-bar, open the Lighting and Shades 
Device Manager (not shown in image):
 – 9.4 and above - Tools > Savant Lighting and Shades 

Device Manager
 – 9.3.5 and below - Tools > Savant Lighting and Keypads

2. Select the gear icon at the bottom of the Configured window 
and choose Group By Device Type.

 HELPFUL! In an existing configuration, when the Savant 
Lighting and Shades/Keypads field is grayed out (inactive), 
this indicates that a change to the Blueprint configuration 
was made and the services need to be generated. Select 
the Generate Services icon in the Blueprint toolbar to 
activate this field. 
When building a new Blueprint configuration and the 
Lighting and Shades/Keypads field in the menu-bar 
is grayed out, the easiest way to activate is to do the 
following:

 – Add a network switch to the Blueprint layout window.
 – Make an Ethernet connection from the network 

switch to the system Host.
 – Select Generate Services

Johnson Home Config

Keypads and ControllersDiscover

Hide bound devices

Configured Devices: 0

+

Expand All
Collapse All

Group By Device Type
Group By Location
Group By Zone Group

Show Lighting Devices
Show Shades

2
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4.2. Discover and Add a Lamp Controller to the Configuration
 

3. Select the Expand icon in the Lighting and Shades Device Manager to reveal the Discovered column (only if the Discovered column is not 
already visible).

4. Select the Discover button to discover and list the lamp controller. Select the Stop Discover button once the lamp controller is listed.
5. Drag and drop the lamp controller into the Configured column. The lamp controller has been added and bound to the Blueprint configuration.

Lighting/Keypad Manager for Smith Home

Keypads and Controllers Loads Lighting ScenesDiscover

Show bound devices

Discovered Devices: 1

Hide bound devices

Configured Devices: 1

1 (1)Lamp Controller
Lamp Controller 1 discovered of 1

3 + 4

Wireless Dimmer Lamp Control

UID: AE000A09003D0085

Wireless Dimmer Lamp Control

UID: 001AAE123A090086
192.168.10.105
1.1.203

IP:
Firmware:

Drag 
and 
Drop

Adds both the keypad
and the controller

Add

5

Type: LMP

Lamp Control
Location: Living Room
Address: XXX

UID: AE000A09003D0085
IP: 192.168.10.105

Firmware: 1.1.203

Using the Lighting and Shades Device Manager, scan the local network for any lamp controllers. The binding process is automatic.

 HELPFUL HINTS!
 – When a lamp controller is selected in the Discovered Column, the LED will blink amber.
 – When a lamp controller is bound and found on the network, a solid green LED appears next to it in the Configured window. If the lamp 

controller is not found on the network, a solid red LED appears next to it in the Configured window. 
 – To list all bound and unbound lamp controllers in the Discovered column, add a check to the Show bound devices checkbox. By default, 

the Show bound devices checkbox is unchecked and any bound lamp controllers won’t appear in the Discovered column. 

 IMPORTANT! The SDE/MacBook running Blueprint must be connected to the same network that the lamp controller is communicating on.

http://savant.com
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4.3. Set the Lamp Controller Properties
The previous section adds the lamp controller to the configuration. Next, a few of the property fields to the lamp controller can be set. Not all fields 
need to be configured for the lamp controller to be deployed.

6. Highlight the lamp controller from the previous section.

NOTE: The discovered window is not needed to complete the remaining instructions, so it is not shown in the following image.
7. Enter a Name that identifies the lamp controller.

NOTE: The name can be updated in either of the two Name fields in this window.
8. Set the Location field. This is typically the room the lamp controller is located.

1 discovered of 1Lamp Controller

Smith Home

Keypads and Controllers Loads Lighting ScenesDiscover

Hide bound devices

Configured Devices: 1

+

Lamp Control
Location: Kitchen
Address: 001

Overview

Wireless Dimmer Lamp Control

Properties for Device: Lamp Control 

Name: Lamp Control 

LMP

001

Type: 
Location: 

Address: 

AE000A9003D0085UID:

Property Value 

Name:
Layout:

Lamp Control

ControlShadesLighting

Unbind

Plugin Module

Kitchen 

Sync... ?

8
7

UID: AE000A9003D0085
IP:

Firmware:

Load

Location: Kitchen

UID: AE000A9003D0085

BLE Gateway: Always On:

6
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5. Upload Configuration
After the Lamp Control is added to Blueprint and configured, the configuration with the Lamp Control information can be uploaded to the Host.

1. To upload the configuration, select the Upload to Master icon from the Blueprint toolbar and send the configuration to the Host. 
 

 

2. In the Configuration must be saved dialog window that opens, read the dialog and select Save and Upload. 
 

 

3. The System Monitor application will automatically open as displayed below. Verify the path to the configuration file is correct. Select Upload when   
satisfied. 
 

 

4. The configuration will now upload to the Host and the Host will begin communicating with the Lamp Control. The Status LED on the side of the Lamp 
Control will illuminate solid (green) indicating it is connected to the network and bound to the configuration running on the Host.

http://savant.com
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Appendix A: Network Requirements
Savant requires the use of business class/commercial grade network equipment throughout the network to ensure the reliability of communication between 
devices. These higher quality components also allow for more accurate troubleshooting when needed.
Connect all Savant devices to the same local area network (LAN) or subnet as the Host. Savant recommends not implementing any type of traffic management, 
packet shaping, band steering, QoS or similar features within the network topology for Savant devices, as this may interfere with performance.

Managing IP Addresses
To ensure that the IP Address will not change due to a power outage, a static IP Address or DHCP reservation should be configured. Savant recommends using 
DHCP reservation within the router. By using this method, IP Addresses for all devices can be managed from a single UI avoiding the need to access devices 
individually.

Setting a Static IP Address
Setting a Static IP Address can be done in the Web UI on the Network Tab.

Setting DHCP Reservation
Setting DHCP reservation varies from router to router. Refer to the documentation for the router to configure DHCP reservation.

Network Changes
It is good practice to reboot (power cycle) the Lamp Control after changing routers, or if the IP address range is changed in the current router.

Cycle Power
 – Disconnect the Lamp Control from the power source.
 – Wait 15 seconds and then reconnect.

To Reset to Factory Defaults
 – Press & Hold the Reset Button on the bottom side of the Lamp Control for 5 seconds until the Status LED starts a rapid blink (red). Release the 

Reset button once the rapid blink begins. Allow 10-15 seconds for the controller to reset. See the LED Status section for LED state information.
 
NOTE: For information on networking requirements, see the Savant Device Networking Guide on the Savant Community.

http://savant.com
https://community.savant.com/Customers/SavSupportLogin
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Appendix B: Provision to the Network - WebUI
If the SmartConnect application is not available, the Lamp Control can be provisioned using the embedded Web UI in the Lamp Control. 

1. Plug the lamp controller into a 120V AC outlet. 

2. By default, a new Lamp Control is set at the factory to be in Access Point Provisioning Mode. If it is, skip this step and proceed to step 3 below. If the Lamp 
Control is in some other state than Access Point Provisioning Mode follow the bulleted steps below to set it to this mode. 

NOTES:
 – Insert a pointed object such as a paper clip into the reset button pinhole. Press and hold the reset 

button for five seconds until LED blinks red, then release.
 – After the reset, the LED will switch to solid yellow while the Lamp Controller boots.
 – After approximately 5-10 seconds, the LED on the side of the Lamp Control starts blinking yellow once 

per second indicating it is in Access Point Provisioning Mode and ready to be provisioned to the local 
network.

 – Refer to Appendix H: LED States for more information.

3. On the MacBook/SDE, select the Wi-Fi icon in the menu bar and select the Lamp Control from the available networks. The Lamp Control will appear as 
Savant[Mac Address]. The Mac Address is the first 12 characters of the Savant UID. The check indicates the controller is connected to your MacBook/SDE.

 HELPFUL INFO: If the UID is not known, the rpmEmbScanner application that is 
accessed through the Launch menu in the Savant Application Manager (SAM) can be 
used to find the Mac Address.

 

4. In the address bar of a browser, enter the following IP address: 192.168.1.1. 

http://savant.com
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5. Select Provisioning to display a list of available networks. 
 

 

6. In the list of available networks, select the network to connect. 

Note: Refer to the Additional Information section below if your network is not in the list 
of available networks.

 

7. Follow the prompts and enter the Passphrase to the network selected. 

8. Once connected, a verification message will appear. 
 

 

9. The Lamp Control is now provisioned to the local network. The LED on the side of the Lamp Control will now blink green indicating it is connected to the 
network but has not established a binding to the Savant Pro System. Refer to Appendix H: LED States.

http://savant.com
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Additional Information
If the desired network does not appear in the list, it can be manually configured to a network by selecting Other SSID at the bottom of the list of available 
networks and follow the prompts. 
 

 

 – The Lamp Control will now be displayed in the Devices on Wi-Fi section in SmartConnect.
 – The status LED on the Lamp Control will now blink green once per second. This indicates it is provisioned to the local network but not bound to the 

configuration running on the Host.

http://savant.com
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Appendix C: Firmware Information
Firmware updates are automatic and occur each time the software is updated on the Savant Control System Host. After a software upgrade, the Host scans the 
network and compares the firmware version loaded in the Lamp Control with the firmware in the updated da Vinci software. If an update is available, the update 
process will begin automatically at that time.

Additional information on the Firmware Upgrade Status and Firmware Revision currently installed on the controller can be accessed through the System Monitor 
Application.

System Monitor > Savant Lighting > Go To Lighting Page > System Health > Firmware Upgrade

Below is the Firmware Upgrade page:

http://savant.com
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Appendix D: Configure Lamp Control to Function as a Switch
Follow the steps described below to configure the Lamp Control to operate as an On/Off switch. The procedure assumes the Lamp Control has already been 
added to the configuration and is working as a Dimmer. 

1. Open the RacePoint Blueprint configuration.  

2. Open the Lighting and Shades Device Manager from the menu bar (Tools > Savant Lighting and Shades Device Manager). 

3. Select the Lighting Scenes tab (see image below for steps 3-6). 

4. Select the Lamp Control load scene. 

5. Modify the Min value of this load scene to 0% and the Max value to 100%. 

6. Select the Sync button and follow the prompts to update the lighting data table with the changes made. 
 

34

5

6
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7. During the Sync operation, the lighting data table opens. Locate the Lamp Control being modified. Change the value in the Entity column of the Lamp 
Control from Dimmer to Switch (see image below). 
 

 

8. Select Done when complete. 

9. Select Generate Services from the RacePoint Blueprint toolbar and follow the prompts.  

 HELPFUL INFO: After Generating the Services, the State Icon in the RacePoint Blueprint toolbar changes to green, verify the Lamp Control in the lighting 
data table is still set to switch (Tools > Settings > Lighting). 

10. Upload the updated file to the Savant Pro System Host. 

11. Test and verify the Lamp Control has switch (On/Off) controls in the Savant Remote and the Savant Pro 8 App. Select On or Off to toggle the load.

http://savant.com
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Appendix E: Bind Using SmartConnect
Once the configuration is uploaded to the Host, the Lamp Control bindings can now be established. 

Before beginning the process, verify the following:
 – The Lamp Control is provisioned and communicating with the local network.
 – The Lamp Control is configured in RacePoint Blueprint and the configuration was uploaded to the Pro System Host.

Tools Required
 – iOS device such as an iPad® or iPhone® that supports Bluetooth V4.0 with the Savant SmartConnect application installed. 

Download and Install SmartConnect
If the SmartConnect Application is not installed on your iOS device, it can be downloaded from the Apple App Store. To find the SmartConnect App on the 
App store, search for Savant SmartConnect. Once located, download to your iOS device. The SmartConnect Application automatically gets installed once 
downloaded.

Once the configuration is uploaded to the Host, the Lamp Control bindings can now be established.
1. Connect the iOS device to the network that the Savant Pro System Host is connected to.

2. Tap the  icon to open the SmartConnect application.
3. Locate the Smart or Pro Host (Savant ID) from the list of devices under the Devices on WiFi section. Tap the Host Controller to open the devices page.
4. On the Devices page that opens (image below), the Lamp Control will be available. A question mark in the field indicates the Lamp Control is not bound   
 to the configuration running on the Host. Tap the Lamp Control to open the Device Binding page.

http://savant.com
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5. A Device Binding page opens (image below) and requests: Push a button on the physical device you would like to bind to this virtual device.

 Using a small pointed object such as a paper clip, press and release the reset button positioned at the bottom of the Lamp Control. Once pressed, the   
 UID for the device being bound is displayed on the Device Binding page. See image in step 6 below.

6. Tap the UID that appeared. This binds the Lamp Control to the configuration running on the Host. The LED on the side of the Lamp Control will now be   
 on solid green indicating it is connected to the network and bound to the configuration running on the Host.

7. Verify the device is bound by tapping the Flash Last Pressed icon. The lamp plugged into the Lamp Control will flash three times and the Status LED on   
 the Lamp Control will blink yellow each time the Lamp flashes. This indicates the Lamp Control is configured and communicating with the Host.

8. Select the <Back button and repeat steps above to bind all Lamp Controls in the configuration to the Savant Control System Host.

http://savant.com
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Unbind Process
There are some scenarios such as when a Host or Lamp Control is being replaced; the Lamp Control needs to be unbound from the configuration running on the 
Host before binding the new Lamp Control device. 

1. Connect the iOS device to the wireless network that the Savant Control system is utilizing.

2. Open the SmartConnect application. 

3. Locate the Smart or Pro Host (Savant ID) from the list of devices under the Devices on WiFi section. Tap the Host Controller to open the devices page.

4. In the Devices page that opens, tap the Lamp Control to open the Device Control page.

5. Tap the Device Binding tab on this page.

6. In the Device Binding page that opens, tap Unbind. 
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7. An Unbind Keypad? window will open. Read the dialog and tap Unbind Device if OK to unbind.

8. The Lamp Control will no longer be bound to the Host and a new Lamp Control can be added.
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Appendix F: Bind Using UID Field in Racepoint Blueprint
Establishing the bindings using the UID field in RacePoint Blueprint is described below. This process is typically used if the Bind/Un-Bind button process does 
not work. This process manually enters the UID into the configuration running in RacePoint Blueprint. 

Savant Lighting and Shades Device Manager - Establish Bindings

Use the SmartConnect application to locate the UID of the Lamp Control. The UID is needed during the binding process. Refer to the Provisioning to the Network 
Using SmartConnect section for information on obtaining the UID through SmartConnect.

1. In the menu bar, select Tools>Savant Lighting and Shades Device Manager.
2. Select the Keypads and Controllers tab.
3. Select the Lamp Control from the list of lighting devices.
4. Double-click the UID field and enter the UID of the Lamp Control (see image below)

Double Click and Enter 
UID of Lamp Controller

5. Repeat steps 3 and 4 above and add the UID to the UID field of all the Lamp Controls in the lighting devices list. Close Savant Lighting and    
 shades when done.
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Populate/Update the Lighting Data Table
Once the Lamp Control(s) are added and configured, the information needs to be populated in the lighting data table. Follow the steps below to do this.

1. Select the  button in bottom right corner of the Keypads tab and the dialog window shown below opens. 

 

B

A

 

2. Using the descriptions below, check or uncheck the appropriate boxes. 

A  Checked – Any user modifications made are discarded. Any boxes checked (Loads, Scenes, Load Scenes, Buttons) will cause the entry in the    
 lighting data table to revert to the default values.
 Unchecked (Default) – Any user modifications made to the data table are transferred to the lighting data table. For this to occur, the boxes    
 described above (Loads, Scenes, Load Scenes, Buttons) that are associated with the updates must be checked.

HELPFUL INFO: When updating or creating a lighting data table, it is recommended that a check be added to only the Loads and Scenes    
boxes. Each box checked adds additional buttons and icons to the Savant Pro 8 or TrueControl II Apps. Adding a check to the Load Scenes and    
Buttons boxes are typically used when troubleshooting.

3. Select the Sync button to update the lighting data table with an updated configuration.

 IMPORTANT! The data table that gets modified only affects the TrueControl II and Savant Pro 8 Apps. Any modifications made here do not affect the Lamp 
Control configurations.
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4. After the Sync button is pressed, the updated lighting data table opens as displayed below.

5. Select Done when Complete.
6. Select the Generate Services icon in the Blueprint toolbar. The State icon will change to blue or green indicating the services for the Lamp Control has   
 been created.
7. Select Update All UI Screens > Sync with Services from the Blueprint toolbar to sync the user interfaces such as the iPad® to the Services created. The   
 State icon will change to green when complete.
8. Select File > Save from the Blueprint menu bar.
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Appendix G: Savant Lighting and Shades Device Manager Basics
1. Navigate to Tools in the upper toolbar.

2. Under Tools, select Savant Lighting and Shades Device Manager.
3. Savant Lighting and Shades Device Manager has three tabs:

 – Keypads and Controllers

 – Loads

 – Lighting Scenes

 – Select Keypads and Controllers.

4. Select the  icon to open the Lighting Devices window.

5. Under the # to Add column, double-click the field associated with the Lamp Control and enter the number of Lamp Control(s) (see image below).

5. Select the Add button to add the Lamp Control to the Blueprint configuration (See image on the previous page). The number of Lamp Controls     
entered is added (See image below). Label and configure the Lamp Control(s).

A
B
C

D

A Enter a name that identifies where the Lamp Control is located. The identifier should make it easy to find the Lamp Control when entering the 
room selected in the Location column described below. To modify, double-click to highlight and enter the new name.

B Displays the layout of the Lamp Control and cannot be modified.

C Select the room or zone where the Lamp Control is located.

D Enter a name that identifies where the load plugged into the Lamp Control is located. The identifier should make it easy to locate the lamp/load 
when entering the room specified in the Location column. To modify, double-click the text and enter a new identifier. The name entered will also 
be displayed in the TrueControl II or Savant Pro App as the device being controlled. 

6. Save the configuration (File > Save from the Blueprint menu bar).
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Load Scenes/Update the Lighting Data Table
When a Lamp Control is added to the Savant Lighting and Shades Device Manager, a load scene for that device is automatically generated. The load scene 
created is by default associated with the Lamp Control added. If modifications to the parameters of the load scene are required, they are modified from within 
the Lighting Scenes tab.

To modify a load scene, follow the steps below.
1. Select the Lighting Scenes tab.
2. Select the Show Load Scene check box in the bottom left corner of the Lighting Scenes window that opens. Adding a check to this box will display the   
 load scene(s) generated in the Scene panel.

 HELPFUL INFO: Selecting Show Load Scenes check box described above is because any load scenes generated when adding a lighting device are not 
initially displayed.

3. In the Scene panel, select the load scene for the Lamp Control added.
4. Modify the fields in the Dimmer tab as required. Use the descriptions in the table below.
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Dimmer Where the load scene settings for a dimmer type device are modified.

Dimmer State Sets the maximum amount of power (in %) that can be applied to the Lamp Control.

Min% / Max% Min: % - Sets the minimum amount of power (in %) required to turn on the load plugged into the Lamp Control.
Max: % - Sets the maximum amount of power (in %) required to light the load to its full capacity.
With these two fields set correctly, the output power sent to the lamp plugged into the Lamp Control is more granular and the power curve 
more linear. These fields may need adjustments because of the different types of lamps available (LED, Incandescent, CFL). 
Auto- Correction Functions:
The Lighting/Keypad Manager has auto correction software built into it so the values set can never exceed the predetermined limits set.
•The Dimmer State can’t be set lower than the Min: % value or higher than the Max: % value. If the value in the Dimmer State field is outside 
these parameters, an alert is displayed.

•If the Min: % value is set higher than the Dimmer State value the Lighting/Keypad Manager adjusts the value to match the Min: % value set.
•If the Max: % value is set lower than the Dimmer State, the Lighting/Keypad adjusts the value to match the Max: % value set.

Fade On Sets the time (seconds) it will take for the load to rise to the level of brightnss set in the Max%.

Fade Off Sets the time (seconds) it takes for the power applied to the load to decrease to Off.

Hold Cycle Time Sets the time it takes for a command to complete when a button is pressed and held. For example, if set to 10 seconds, it will take 10 
seconds for the load to ramp from 0 to the preset level set in the load scene.

Scene is Active Sets the feedback or response observed in the TrueControl II or Savant App. For example, if set to Exact, the feedback observed in the 
Savant or TrueControl II App follows how the setting Exact will react.
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Appendix H: LED States
Off - No Power

On Solid (Green) – Connected to the network and bound to the configuration running on the Savant Control System Host.

On Solid (Yellow) - Lamp Control is booting after being reset.

On Solid (Red) - Error Mode caused by an over current condition. When this occurs, unplug the Lamp Control, wait ten seconds and plug back in. This will reset 
the error condition.

Blinks Once (Yellow) – In Access Point Provisioning Mode and ready to be provisioned to the local network.

Blinks Once (Green) – Provisioned and communicating with the local network. Not currently communicating with the Savant Control System Host (Not bound 
to the Host).

Rapid Blink (Red) - The reset button was held down for at least five seconds. When button is released, the rapid blink will stop and the Lamp Control will reset 
to Access Point Provisioning Mode.

Rapid Blink (Yellow) – When activating the locate feature, the LED will blink yellow. 

Blinking Yellow/Green - Firmware is updating.
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Important Notice

Disclaimer
Savant Systems, Inc. reserves the right to change product specifications without notice, therefore, the information presented herein shall not be construed 
as a commitment or warranty. 
Savant Systems, Inc. shall not be liable for any technical or editorial errors or omissions contained herein or for incidental or consequential damages 
resulting from the performance, furnishing, reliance on, or use of this material.

Patents
Certain equipment and software described in this document is protected by issued and pending U.S. and foreign patents.
All products and services are trademarks or registered trademarks of their respective manufacturer. 

Coypright
This document contains confidential and proprietary information protected by copyright. All rights reserved. Copying or other reproduction of all or parts 
of this document is prohibited without the permission of Savant Systems.

Trademarks
© 2022 Savant Systems, Inc. All rights reserved. Savant, Savant App, TrueImage, Savant Host, Now You Can, RacePoint Blueprint, Single App Home, 
TrueCommand, TrueControl, and the Savant logo are trademarks of Savant Systems, Inc.
AirPlay, Apple, AirPort Express, AirPort Extreme, Apple TV, Apple Remote Desktop, FireWire, iMac, iTunes, iPad, iPad mini, iPad Air, iPhone, MacBook, Mac 
and OS X are trademarks or trade names of Apple Inc. iOS is a trademark of Cisco®. Android, Google, Google Play, and other Google marks are trademarks 
of Google, Inc. Wi-Fi is a registered trademark of the Wi-Fi Alliance®. NETGEAR®, the NETGEAR Logo and ProSAFE are trademarks of NETGEAR, Inc. 
Extreme™ is a trademark of Extreme Networks, Inc.
All other brand names, product names, and trademarks are the property of their respective owners.

Technical and Sales Support
Savant Systems, Inc. is dedicated to providing prompt and effective support in a timely and efficient manner.
 – To contact Savant Support, access the Savant Customer Community and enter a support Case ticket.
 – To contact Savant Sales, visit Savant.com and select Contact Us to locate a local sales representative in your area.

http://savant.com
https://community.savant.com/Customers/Comm_Login
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